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Introduction
The EPL200 is a compact and flexible open-frame PLC board.
It is configured as a control unit and connectivity node, complete with RS485 serial (Modbus RTU) , 
Ethernet (Modbus TCP/IP) and integrates analogue-digital I/O.
The board is programmable with the LogicLab development environment, which can be downloaded 
from www.pixsys.net.

1	 Safety guidelines
Read carefully the safety guidelines and programming instructions contained in this manual before 
connecting/using the device.
Disconnect power supply before proceeding to hardware settings or electrical wirings to avoid risk of 
electric shock, fire, malfunction.
Do not install/operate the device in environments with flammable/explosive gases. 
This device has been designed and conceived for industrial environments and applications that rely 
on proper safety conditions in accordance with national and international regulations on labour 
and personal safety. Any application that might lead to serious physical dama ge/ life risk or involve 
medical life support devices should be avoided.
Device is not conceived for applications related to nuclear power plants, weapon systems, flight 
control, mass transportation systems.
Only qualified personnel should be allowed to use device and/or service it and only in accordance to 
technical data listed in this manual.
Do not dismantle/modify/repair any internal component.
Device must be installed and can operate only within the allowed environmental conditions.
Overheating may lead to risk of fire and can shorten the lifecycle of electronic components.

1.1	 Organization of safety notice
Safety notices in this manual are organized as follows:

Safety notice Description

Danger! Disregarding these safety guidelines and notices can be life-threa-
tening.

Warning! Disregarding these safety guidelines and notices can result in severe 
injury or substantial damage to property.

Information! This information is important for preventing errors.

1.2	 Safety Precautions

Danger!
CAUTION - Risk of Fire and Electric Shock
This product is UL listed as open type process Control Equipment. It must be mounted in 
an enclosure that does not allow fire to escape externally.

Danger!

If the output relays are used past their life expectancy, contact fusing or burning may 
occasionally occur.
Always consider the application conditions and use the output relays within their 
rated load and electrical life expectancy. The life expectancy of output relays varies 
considerably with the output load and switching conditions.

Warning!
Devices shall be supplied with limited energy according to UL 61010-1 3rd Ed, section 9.4 
or LPS in conformance with UL 60950-1 or SELV in conformance with UL 60950-1 or Class 
2 in compliance with UL 1310 or UL 1585.

Warning! Loose screws may occasionally result in fire.
For screw terminals, tighten screws to tightening torque is 0.22 Nm

Warning!

A malfunction in the Digital Controller may occasionally make control operations 
impossible or prevent alarm outputs, resulting in property damage. To maintain safety 
in the event of malfunction of the Digital Controller, take appropriate safety measures, 
such as installing a monitoring device on a separate line.

Table of contents
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1.3	 Precautions for safe use
Be sure to observe the following precautions to prevent operation failure, malfunction, or adverse 
affects on the performance and functions of the product. Not doing so may occasionally result in 
unexpected events. Do not handle the Digital Controller in ways that exceed the ratings.
• The product is designed for indoor use only. Do not use or store the product outdoors or in any of 
the following places.
- Places directly subject to heat radiated from heating equipment.
- Places subject to splashing liquid or oil atmosphere.
- Places subject to direct sunlight.
- Places subject to dust or corrosive gas (in particular, sulfide gas and ammonia gas).
- Places subject to intense temperature change.
- Places subject to icing and condensation.
- Places subject to vibration and large shocks.
• Installing two or more controllers in close proximity might lead to increased internal temperature 
and this might shorten the life cycle of electronic components. It is strongly recommended to install 
cooling fans or other air-conditioning devices inside the control cabinet.
• Always check the terminal names and polarity and be sure to wire properly. Do not wire the terminals 
that are not used.
• To avoid inductive noise, keep the controller wiring away from power cables that carry high 
voltages or large currents. Also, do not wire power lines together with or parallel to Digital Controller 
wiring. Using shielded cables and using separate conduits or ducts is recommended. Attach a surge 
suppressor or noise filter to peripheral devices that generate noise (in particular motors, transformers, 
solenoids, magnetic coils or other equipment that have an inductance component).
When a noise filter is used at the power supply, first check the voltage or current, and attach the 
noise filter as close as possible to the Digital Controller. Allow as much space as possible between 
the Digital Controller and devices that generate powerful high frequencies (high-frequency welders, 
high-frequency sewing machines, etc.) or surge.
• A switch or circuit breaker must be provided close to device. The switch or circuit breaker must be 
within easy reach of the operator, and must be marked as a disconnecting means for the controller.
• Wipe off any dirt from the Digital Controller with a soft dry cloth. Never use thinners, benzine, alcohol, 
or any cleaners that contain these or other organic solvents. Deformation or discoloration may occur.
• The number of non-volatile memory write operations is limited. Therefore, use EEprom write mode 
when frequently overwriting data, e.g.: through serial port communications.

1.4	 Environmental policy / WEEE
Do not dispose electric tools together with household waste material.
According to European Directive 2012/19/EU on waste electrical and electronic equipment and its 
implementation in accordance with national law, electric tools that have reached the end of their life 
must be collected separately and returned to an environmentally compatible recycling facility.

2	 Model identification
The EPL200 series includes :
OPEN FRAME PLC; 1 ETHERNET; 2 RS485; 6 Analogue inputs; 1 Analogue Outputs; 10 Digital Inputs; 4 
Relays 5A, 4 Relays 10A, 4 Digital outputs.
The models differ in power supply according to the following table:
EPL200-1A 24V AC/DC
EPL200-1BC 115-230V AC
EPL200-1D 12V DC
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3	 Technical data
3.1	 General characteristics

Power supply
EPL200-1A 24 V AC/DC ± 10%
EPL200-1BC 115-230 V AC ± 10%
EPL200-1D 12 V DC ± 10%

Consumption 5W
Operating conditions Temperatura: 0-45°C; umidità 35..95 RH% senza condensa
Protection IP20
Weight Circa 100 g

3.2	 Hardware characteristics
CPU ARM Cortex H7 @ 480MHz
Memory Flash 2 Mb / RAM 1 Mb

Digital inputs 8 inputs PNP 12-24Vdc
2 inputs NPN 12-24Vdc

V
IL

 = 4,4V, V
IH

 = 8,2V 
V

IL
 = 2,5V, V

IH
 = 4,1V

Encoder/counter 
inputs

3 encoder/counter superimposed to the
digital inputs PNP

Resolution 32 bit
Maximum frequency 100KHz

Analogue inputs

4 inputs configurable via software
Thermocouples: type K, S, R, J, T, E, N, B; 
with automatic cold junction compensation 
from 0..50°C.
Thermoresistance: PT100, PT500,
PT1000, Ni100, PTC1K, NTC10K (β 3435K)
Potentiometer: 1..150 kΩ

Tolerance: (@ 25 °C)
± 0.2% ± 1 digit (on F.s.)
Resolution: 16bit

2 inputs configurable via software
Input VI: 0-10V, 0-20 o 4-20mA.

Tolerance: (@ 25 °C)
± 0.2% ± 1 digit (su F.s.)
Resolution: 16bit

Relay outputs

4 outputs relay contact NO common unique Q0.0-Q0.3 Max 5A for each  
output

4 output relay contact NO 
common unique for Q0.4-Q0.5
common unique for Q0.6-Q0.7

Q0.4-Q0.7 Max 10A for each 
output

Digital outputs 4 outputs open collector PNP Max 25mA for each output
Q1.0-Q1.3

Analogue outputs 1 output configurable via software:
0-10V o 4-20mA Resolution: 16bit

RS485 2 porte  con protocollo Modbus RTU 
master/slave Up to 115200 baud

Ethernet port With Modbus TCP master/slave protocol

3.3	 Software characteristics
Minimum cycle time 1mS
Public objects - 
Parameters (non-volatile) 3800 words 150 year data retention

Public objects - 
Status variables (volatile) 4096 words

Retain Variables 2KB 60 days data retention with rechargeable battery capacitor
Retain Datablock 2KB 60 days data retention with rechargeable battery capacitor
PLC code size 476KB
PLC data size 128KB
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4	 Dimension and installation

5	 Electric connections
This instrument was designed and built in compliance with the Low Voltage Directives 2006/95/ CE, 
2014/35/EU (LVD) and Electromagnetic compatibility 2004/108/EC and 2014/30/EU (EMC). 
For installation in industrial environments it is a good rule to follow the precautions below: 
•	 Distinguish the power supply line from the power lines. 
•	 Avoid the proximity with contactor units, electromagnetic contactors, high power motors and 

use filters in any event. 
•	 Avoid the proximity with power units, particularly if with phase control. 
•	 The use of network filters is recommended on the power supply of the machine in which the 

instrument will be installed, particular in case of 230 VAC power supply. The instrument is devised 
to be assembled with other machines. Therefore, the EC marking of the instrument does not 
exempt the manufacturer of the system from the safety and conformity obligations imposed for 
the machine as a whole. 

•	 Wiring of pins use crimped tube terminals or flexible/rigid copper wire with diameter 0.25 to 1.5 
mm2 (min. AWG28, max. AWG16, operating temperature: min. 70°C). Cable stripping lenght 7 to 
8 mm.
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5.1	 Wiring diagram

5.1.a	 Power supply

12 VDC
24 VAC/VDC
115..230 VAC

5.1.b	 Digital inputs PNP 12..24Vdc

2: Input I0.0
3: Input I0.1
4: Input I0.2
5: Input I0.3
6: Input I0.4
7: Input I0.5
39: Input I0.6
40: Input I0.7

5.1.c	 Digital inputs NPN 12..24Vdc

46: Input I1.0
47: Input I1.1
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5.1.d	 Analogue inputs for thermocouples

Thermocouples K, S, R, J, T, E, N, B
Respect the polarity
For any extensions, use compensated cable and terminals 
suitable for the thermocouple used

5.1.e	 Analogue inputs for 2 wires thermoresistances

Termoresistances with 2-wire connection
Linear potentiometers

5.1.f	 Analogue inputs for 3 wires thermoresistances Pt100 , Ni100

Use cables of the same cross-section for the 3-wire connection

5.1.g	 Analogue inputs for normalised signals

Voltage signals 0..10V;
Current signals 0..20 mA, 4..20mA

5.1.h	 Relay outputs Q0.0..Q0.3

Q0.0 .. Q0.3

5A 250 VAC
5A 30VDC
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5.1.i	 Relay outputs Q0.4..Q0.7

Q0.4.. Q0.5

10A 250VAC
10A 30VDC

5.1.j	 Digital outputs open collector

Max 25mA for each output.

5.1.k	 Analogue output AO1

Configurable:
0-10 V with 30000 points ±0.3% (on F.S.) @25 °C;
load >= 1 KΩ
4-20 mA with 25000 points ±0.3% (on F.S.) @25 °C;
load <= 500Ω

5.1.l	 Push-Pull Encoder inputs

Use only push-pull encoders
Maximum frequency 100KHz

5.1.m	 Counter inputs

Counter inputs:
2: Counter 1 , PNP
5: Counter 2 , PNP
46: Counter 3 , NPN

Maximum frequency 100KHz
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5.1.n	 Serial COM1/RS485

26: (B+) RS485+
27: (A-) RS485-
28: (C) Reference 
Connect any cable shield to ground

5.1.o	 Serial COM2/RS485

1,2: +V Out
4: (B+) RS485+
5: (A-) RS485-
3,6 : (C) Reference 
7,8: - V Out

5.1.p	 Ethernet

10/100 Mbit Ethernet port for programming and network 
connectivity.

5.1.q	 USB

USB 2.0 port for Backup / Restore of applications and mass 
storage functionality (memory must be formatted in FAT/FAT32).

5.1.r	 S1 button for system’s Backup / Restore (internal)
Backup:
The backup procedure allows the complete configuration of the device to be 
saved to a USB memory of both the code and the retintive memories. 
1 - Switch on the PLC 
2 - Insert a USB memory (external)
3 - Open the front cover and press S1 button for approximately 8 seconds (the 
green CONFIRM led lights up).
4 - Release the S1 button
5 - Wait for the completion of the backup procedure.
During the procedure, the red RUN LED flashes and the progress of the 
procedure is indicated by the LEDs lighting up in sequence from I.0.0 to I/Q.1.7. 
The yellow COM LED indicates the presence of the USB memory.
At the end of the procedure, the green RUN LED lights up steadily.
In case of errors during the procedure, the red RUN LED lights up steadily.
6 - Switch off the PLC, remove the USB memory and switch the device on again.

If the programme on the PLC is password-protected, a Password.txt file containing the programme 
protection password must be placed in the root of the USB memory, otherwise the backup 
procedure will not be performed. Once the backup is executed, the file can be removed from the 
memory.
At the end of the backup, a BackupLog.txt file containing the outcome of the procedure will be 
generated in the root of the USB memory.
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Restore:
1 - Insert a USB memory containing the backup with the PLC switched off.
2 - Switch on the PLC while holding down the S1 button (the green CONFIRM 
LED lights up).
3 - Wait for the completion of the Restore procedure.
During the procedure the red RUN LED flashes and the progress of the 
procedure is indicated by the LEDs I.0.0 to I/Q.1.7 lighting up in sequence. The 
yellow COM LED indicates the presence of the USB memory.
At the end of the procedure, the green RUN LED lights up steadily.
In case of errors during the procedure, the red RUN LED lights up steady.
5 - Switch off the PLC, remove the USB memory and switch the device.

5.2	 Meaning of the status indicators (LEDs)
 RUN Fixed on: indicates that PLC is in STOP status
 RUN Fixed on: indicates that PLC is normally running

 RUN Alternating flash every 0,5s indicates that the device discovery procedure is running
 COM It turns on of 100 ms for each communication frame sent through COM1/RS485 port
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6	 Suite LogicLab
The LogicLab Suite is Pixsys’ development environment for programming PLC EPL200.
The suite can be downloaded from the download area of the pixsys.net website and does not require 
activation codes. It is compatible with all versions of Windows 32/64bit starting from Windows XP SP3 
and is available in English and Italian. 
Once you have downloaded the setup file onto your computer, start the installation and follow the 
procedure. Once the programme is installed, it starts via the  “LogicLab” icon on the desktop or from 
the “Start” menu > “PixsysSuite” > “LogicLab”.

6.1	 Change language

To change the display language, open the options 
window from the ‘File’ > ‘Options’ menu, switch to the 
‘Language’ tab, select ‘ITA - Italian’ and press ‘Select’.
Then confirm with “OK” and finally close and reopen 
LogicLab for the changes to take effect.

6.2	 Creation - loading of a project

LogicLab start screen
•	 Once the application is launched, a series of 

options are presented to create or open a 
project, scan the network for connected devices 
recognised by the development environment, or 
select one of the devices.

Scan network…
•	 By clicking on the Scan Network button, LogicLab 

performs a search for all programmable devices 
present on the network and fills in the “Scan 
result” table

•	 Depending on the type of device detected, 
certain operations are possible directly on the 
selected device via the buttons in the table.

•	 For the EPL200, the button  can be used to 
initiate the discovery mode on the selected 
device: the RUN LED flash alternately red/green 
for about 5 seconds, so as to be able to establish 
with certainty whether it is the right device 
if more than one of the same type has been 
detected during the scan.

•	 For the PL280, you can use the button  to 
open a screen where you can change the device’s 
network settings.
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Opening an existing project:
•	 With LogicLab open, click on the “Open Project” 

button or select one of the last open projects 
from the proposed list.

•	 With LogicLab closed, enter the project folder 
and double-click on the file with the desired 
project name, which will have the icon and 
extension “.plcprj”.

Create a new project:
•	 Press the “New Project” button or, from the “Scan 

result” table, select the device you want to work 
on and press the button .

•	 In the window that appears, type a name for the 
project and identify the folder where the project 
files will be placed. Finally, select the device to be 
programmed.

Information! by selecting the “respect uppercase/lowercase letters” flag, a variable containing an 
uppercase letter will be understood as different from another variable of the same name but with that 
lowercase letter. We therefore recommend leaving this selection disabled, to avoid confusion when 
writing programme code.

6.3	 Link to target
Listed below are the requirements for the correct connection between the target (device to be 
programmed) and the PC development environment (LogicLab).

Requirements to be checked on the target:
•	 device switched on and started up
•	 onfigured with a static IP address compatible with the network where it is located and the PC 

with which it is to connect. By default, the IP address of the device is 192.168.0.99, so the PC where 
it is being developed must have the same network and class (in this case 192.168.0.XXX) but a 
different physical address (i.e. the last 3 digits of the IP address, with any number between 1 and 
255, other than 99). If it is necessary to change the IP address of the device from the default one, 
please refer to the instructions in the previous paragraph.

•	 network cable connection (direct or cross) directly to the PC or via a network switch

Requirements to be verified on the development PC:
•	 IP address compatible with the existing network where it is located and with the IP address 

configured in the target (see previous points)
•	 Antivirus/firewall allowing connection to devices in the network (these are usually already 

configured correctly)
•	 LogicLab configured to connect to the connected target that you want to programme: to do 

this, navigate to the “On Line” > “Set up communication” menu and in the window that appears, 
press the “Properties” button and then under “IP Address” enter the IP address of the target, leaving 
everything else unchanged. In the case of very slow networks or a network configuration with 
several switches, you can increase the “Timeout” value (in mS).
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The image shows the default configuration

Confirm all windows by pressing “OK” and save via the icon  or via the menu “file”> “Save Project”.
At this point, to check that the configuration of LogicLab and the target is correct, you can connect 
by pressing the icon  or from the menu “On Line” > “Connect”. If the connection is successful, the 
status bar in the bottom right-hand corner will display “CONNECTED” and “NO CODE” to indicate that 
the target is connected and has no code in it, or “CODE DIFF” to indicate that the code being displayed 
does not correspond to the code in the target.

6.4	 Compiling and downloading the code
Once you have entered the project code, you must compile it to check that there are no errors, by 
pressing the F7 key, via the icon  or from the menu “Project” > “Compile”.
If the compilation is successful, you can transfer the programme to the target by pressing the F5 key, 
via the icon  or from the menu “On Line” > “Transfer code”.
At this point, the status bar will display “CONNECTED” and “SOURCE OK” indicating that the programme 
running in the target corresponds to the one being displayed on the PC.

6.5	 The watch window
If the programme running in the target corresponds to the one being displayed on the 
PC, the status bar will display “CONNECTED” and “SOURCE OK” and you can then use the 
“Watch” window to check, in real time, the status of the variables used in the project. To 
enable the “Watch” window, press CTRL+T or use the “View” menu > “Tool Window” > “Watch”.  
To add a variable to the “Watch” window, simply drag it inside or press the icon  and select it 
manually.

From now on, the “Watch” window will begin to 
display the value of the variable entered, in real time.

Using the appropriate buttons  it is also possible to save, load and add to an existing watch 
list.
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If you wish to change the display format, simply select 
the variable and press the icon 
From the window that appears, select the desired 
format and confirm with “OK”.

7	 EPL200’s local resources “Local IO Mapping“
The hardware resources available in the EPL200 are available in the “Local IO Mapping” section of the 
programme, subdivided into categories in order to make them more usable and easier to use. The 
“Parametrization” section allows all the parameters governing the operation of the EPL200 to be set. 
Parameter configuration is automatically handled during the initialisation phase of the PLC. Further 
parameter changes “on the fly” during program execution must be made by calling up the system 
function “sysApplyIOConfiguration(0);”

The “Local IO Mapping” management makes it possible 
to map all local resources available in the EPL200 to 
variables that can be used by the programme.
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7.1	 Parametrization
1	 Sensor type AI1
2	 Sensor type AI2
3	 Sensor type AI3
4	 Sensor type AI4

Analogue input configuration / sensor selection
 0	 Disable (Default)
 1 	 Tc K	 -260 °C..1360 °C
 2	 Tc S	 -40 °C..1760 °C
 3	 Tc R	 -40 °C..1760 °C
 4 	 Tc J 	 -200 °C..1200 °C
 5 	 Tc T 	 -260 °C..400 °C
 6 	 Tc E 	 -260 °C..980 °C
 7 	 Tc N 	 -260 °C..1280 °C
 8 	 Tc B 	 100 °C..1820 °C
 9 	 PT100 	 -100 °C..600 °C
10 	 NI100 	 -60 °C..180 °C
11 	 NTC-10K 	 -40 °C..125 °C 
12 	 PTC-1K 	 -50 °C..150 °C
13 	 PT500 	 -100 °C..600 °C
14 	 PT1000  	 -100 °C..600 °C
15 	 Potentiometer (set the value on param 20..23)
16	 Compensation Pt100 (only for 2 , 3 params)

5	 Sensor type AI5
6	 Sensor type AI6

Analogue input configuration / sensor selection
 0	 Disable (Default)
1 	 0..10V
2 	 0..20mA
3 	 4..20mA

7	 Degree
0	 °C 	 (Celsius) (Default)
1	 °F 	 (Fahrenheit)
2	 K 	 (Kelvin)

8	 Lower limit input AI1
9	 Lower limit input AI2
10	 Lower limit input AI3
11	 Lower limit input AI4
12	 Lower limit input AI5
13	 Lower limit input AI6

Lower limit of analogue input only for normalised signals. Ex: with input 4..20 mA this parameter 
indicates value associated to 4 mA
-32768..+32767, Default: 0.

14	 Upper limit input AI1
15	 Upper limit input AI2
16	 Upper limit input AI3
17	 Upper limit input AI4
18	 Upper limit input AI5
19	 Upper limit input AI6

Upper limit of analogue input only for normalised signals. Ex: with input 4..20 mA this parameter 
indicates value associated to 20 mA 
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-32768..+32767, Default: 1000

20	 Potentiometer Value AI1
21	 Potentiometer Value AI2
22	 Potentiometer Value AI3
23	 Potentiometer Value AI4

Set the value of the potentiometer connected to analogue input.
1..150 kohm, Default: 10kohm

26	 Linear Input over Limits AI1
27	 Linear Input over Limits AI2
28	 Linear Input over Limits AI3
29	 Linear Input over Limits AI4
30	 Linear Input over Limits AI5
31	 Linear Input over Limits AI6

For linear input, it allows the process to exceed the minimum and maximum numerical limits 
(Par. 8..13 and 14..19).
0 Off
1 On

32	 Offset calibration AI1
33	 Offset calibration AI2
34	 Offset calibration AI3
35	 Offset calibration AI4
36	 Offset calibration AI5
37	 Offset calibration AI6

Value added/subtracted to the process value (ex: normally used to correct environmental 
temperature).
-10000..+10000 [digit] (degrees.tenth for temperature sensors). Default 0.

38	 Gain calibration AI1
39	 Gain calibration AI2
40	 Gain calibration AI3
41	 Gain calibration AI4
42	 Gain calibration AI5
43	 Gain calibration AI6

Value multiplied to the process value to calibrate the working point. Ex: to correct the range from 
0..1000°C showing 0..1010°C, set the parameter to -1.0
-1000 (100.0%)...+1000 (+100.0%), Default: 0.0.

44 - 49	 Reserved

50	 Input filter AI1
51	 Input filter AI2
52	 Input filter AI3
53	 Input filter AI4
54	 Input filter AI5
55	 Input filter AI6

Analogue input reading filter: increases the stability of the analogue reading value. Indicates the 
number of samples to be averaged in the process calculation.
1...50. (Default: 10)

56	 Maximum difference for new sampling AI1
57	 Maximum difference for new sampling AI2
58	 Maximum difference for new sampling AI3
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59	 Maximum difference for new sampling AI4
60	 Maximum difference for new sampling AI5
61	 Maximum difference for new sampling AI6

Defines the maximum absolute value of difference between the current process value and the 
new sampling to consider this value acceptable (and therefore inserted in the average managed 
by the parameter “50..55 Input filter”) or reject it.
1..32767 [tenth of °C or digit], Default: 10,0 °C

62	 Maximum duration of sampling discard AI1
63	 Maximum duration of sampling discard AI2
64	 Maximum duration of sampling discard AI3
65	 Maximum duration of sampling discard AI4
66	 Maximum duration of sampling discard AI5
67	 Maximum duration of sampling discard AI6

Determines the maximum duration for which the analogue input samples can be discarded if 
considered unacceptable (see parameters 72..73). After this time, any sampling value will be 
considered valid.
0..200 [tenth of second], Default: 1,0 s

68 - 70	 Reserved

71	 Output type AO1
Selects the analogue output operating mode.
0	 0-10 V (Default)
1	 4-20 mA

72	 Lower Limit Analogue Output AO1
Lower limit continuous output range (value associated with 0 V or 4 mA).
-32768...+32767 [digit], Default: 0.

73	 Upper Limit Analogue Output AO1
Upper limit continuous output range (value associated with 10V or 20mA).
-32768...+32767 [digit], Default: 1000.

74	 A01 output status in error
Defines how the output behaves in the event of an error.
0	 Keeps value (Default)
1	 Set value of next param

75	 A01 output value in error
Determines the value of the analogue output in the event of an error or fault.
The value must be between the minimum and maximum limits of the output.
-32768..+32767 [digit], Default: 0.

76	 Digital input filter
Defines the time for which the digital input must remain stable before being considered valid.
0..250 [base 1,0 ms], Default: 5 x 1,0 = 5 ms.

77	 Reserved

78	 Encoder/counter setup 1
79	 Encoder/counter setup 2
80	 Encoder/counter setup 3

Determines the operating mode of the one-way encoder or counter input.
0	 Disable
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1 	 Counter Up
2 	 Counter Down
3 	 Encoder x2 phase A-B
4 	 Encoder x4 phase A-B
5 	 Encoder x2 phase A-B-Z
6 	 Encoder x4 phase A-B-Z

81	 Encoder/counter preset 1
82	 Encoder/counter preset 2
83	 Encoder/counter preset 3

Determines the value that will be loaded into the count register of the encoder or counter when 
the load command occurs.
-2147483648..2147483647  [digit], Default: 0.

87	 Offline time
Determines the time in ms taken by the plc to activate the “error” outputs in the event of a 
communication failure with the built-in I/O.
0 Off
1 to 60000 time in ms

88 - 150	 Reserved

7.2	 Digital Inputs
IW0.0	 System digital inputs word

This word contains the status of the 10 digital inputs of the EPL200.
Bit 0: I.0.0
…
Bit 7: I.0.7
Bit 8: I.1.0
Bit 9: I.1.1

7.3	 Digital Outputs
QW0.0	 System digital outputs word

This word contains the status of the 16 digital outputs of the EPL200.
To activate the outputs, set the corresponding bit on this word to “1”.
Bit 0: Q.0.0
…
Bit 7: Q.0.7
Bit 8: Q.1.0
…
Bit 11: Q.1.3

7.4	 Analogue Inputs
IW1.0  	 System analogue input AI1
IW1.1	 System analogue input AI2
IW1.2  	 System analogue input AI3
IW1.3  	 System analogue input AI4
IW1.4  	 System analogue input AI5
IW1.5  	 System analogue input AI6

These words contain the value of the EPL200’s analogue inputs. For inputs configured as 
temperature sensors, the value is expressed in tenths of a degree. In the case of an out-of-range, 
short or open analogue input, the value reported will be -32768 (short) or 32767 (open).
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7.5	 Analogue Outputs
QW1.0	 System analogue output AO1

These words contain the value of the analogue outputs of the EPL200. To set a certain value 
on the corresponding analogue output, write the value on these words in accordance with the 
minimum and maximum output limits set in the parameterisation table.

7.6	 Encoder/counter
EV01 	 System encoder 1 value
EV02 	 System encoder 2 value
EV03 	 System encoder 3 value

These 32-bit variables contain the value in counts of the encoders/counters of the EPL200

EC1000_1	 System encoder 1 counts 1s
EC1000_2	 System encoder 2 counts 1s
EC1000_3	 System encoder 3 counts 1s

These 32-bit variables contain the number of encoder/counter counts of the EPL200 detected in 
the last second. The data is updated every 1,0s.

EC100_1	 System encoder 1 counts 100ms
EC100_2	 System encoder 2 counts 100ms
EC100_3	 System encoder 3 counts 100ms

These 32-bit variables contain the number of encoder/counter counts of the EPL200 detected in 
the last 100ms. The data is updated every 100ms

ECMD_1	 System encoder 1 command
ECMD_2	 System encoder 2 command
ECMD_3	 System encoder 3 command

These words are used to send commands to the encoders.
Bit0 = Load preset value
Bit1 = Preset charge at next Z pulse
Command bits are automatically set to 0 once command is executed
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Warranty terms
Pixsys srl warrants its electronic devices for 12 months from Invoice date. Pixsys liability shall be limited 
to repairing (or replacing at its option) any defective product which is returned with RMA (Return 
Material Authorization) priorly obtained on Pixsys website and to be clearly marked on documents. 
Pixsys shall not be responsible for accident, neglect, misuse, damage to objects or people caused 
using the devices outside their specifications or outside any published performance data, including 
unauthorized and unqualified repairing or failure to provide proper environmental conditions. In 
no event shall Pixsys liability exceed the purchase price of the product(s). Warranty does not cover 
any damage arising from post-sale installation of software applications and specifically any damage 
caused by malware. Technical assistance by Pixsys which should be required to restore OS will be 
subject to assistance fee prevailing at time of request

Notes / Updates
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Introduzione
EPL200 è una scheda PLC open-frame compatta e flessibile.
Si configura come unità di controllo e nodo di connettività, completa di seriale RS485 (Modbus RTU) , 
Ethernet (Modbus TCP/IP) e integra I/O analogico-digitali.
La scheda è programmabile con l’ambiente di sviluppo LogicLab scaricabile dal sito www.pixsys.net

1	 Norme di sicurezza
Prima di utilizzare il dispositivo leggere con attenzione le istruzioni e le misure di sicurezza contenute in 
questo manuale. Disconnettere l’alimentazione prima di qualsiasi intervento su connessioni elettriche 
o settaggi hardware al fine di prevenire il rischio di scosse elettriche, incendio o malfunzionamenti. 
Non installare e non mettere in funzione lo strumento in ambienti con sostanze infiammabili, gas o 
esplosivi. Questo strumento è stato progettato e realizzato per l’utilizzo convenzionale in ambienti 
industriali e per applicazioni che prevedano condizioni di sicurezza in accordo con la normativa 
nazionale e internazionale sulla tutela della delle persone e la sicurezza dei luoghi di lavoro. Deve 
essere evitata qualsiasi applicazione che comporti gravi rischi per l’incolumità delle persone o sia 
correlata a dispositivi medici salvavita. Lo strumento non è progettato e realizzato per installazione 
in centrali nucleari, armamenti, sistemi di controllo del traffico aereo o della sicurezza in volo, sistemi 
di trasporto di massa. L’utilizzo/manutenzione è riservato a personale qualificato ed è da intendersi 
unicamente nel rispetto delle specifiche tecniche dichiarate in questo manuale.
Non smontare, modificare o riparare il prodotto né toccare nessuna delle parti interne.
Lo strumento va installato e utilizzato esclusivamente nei limiti delle condizioni ambientali dichiarate. 
Un eventuale surriscaldamento può comportare rischi di incendio e abbreviare il ciclo di vita dei 
componenti elettronici.

1.1	 Organizzazione delle note di sicurezza
Le note sulla sicurezza in questo manuale sono organizzate come segue:
Note di sicurezza Descrizione

Danger! La mancata osservanza di queste linee guida e avvisi di sicurezza 
può essere potenzialmente mortale.

Warning! La mancata osservanza di queste linee guida e avvisi di sicurezza 
può comportare lesioni gravi o danni sostanziali alla proprietà.

Information! Tali informazioni sono importanti per prevenire errori.

1.2	 Note di sicurezza

Danger!
ATTENZIONE - Rischio di incendio e scosse elettriche. Questo prodotto è classificato 
come apparecchiatura di controllo del processo di tipo a barra DIN. Deve essere montato 
in un involucro che non permetta al fuoco di fuoriuscire esternamente.

Danger!

Se i relè di uscita vengono utilizzati oltre la loro aspettativa di vita, possono verificarsi 
occasionalmente fusioni o bruciature dei contatti.
Considerare sempre le condizioni di applicazione e utilizzare i relè di uscita entro il loro 
carico nominale e l’aspettativa di vita elettrica. L’aspettativa di vita dei relè di uscita varia 
notevolmente con il carico in uscita e le condizioni di commutazione.

Warning!
I dispositivi devono essere alimentati a energia limitata secondo UL 61010-1 3rd Ed, 
sezione 9.4 o LPS in conformità con UL 60950-1 o SELV in conformità con UL 60950-1 o 
Classe 2 in conformità con UL 1310 o UL 1585.

Warning! Occasionalmente le viti troppo allentate possono provocare un incendio.  
Per i morsetti a vite, serrare le viti alla coppia di serraggio di 0,22 Nm

Warning!

Un malfunzionamento nel controllore digitale può occasionalmente rendere impossibili 
le operazioni di controllo o bloccare le uscite di allarme, con conseguenti danni 
materiali. Per mantenere la sicurezza, in caso di malfunzionamento, adottare misure di 
sicurezza appropriate; ad esempio con l’installazione di un dispositivo di monitoraggio 
indipendente e su una linea separata.

Indice degli argomenti
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1.3	 Precauzioni per l’uso sicuro
Assicurarsi di osservare le seguenti precauzioni per evitare errori, malfunzionamenti o effetti negativi 
sulle prestazioni e le funzioni del prodotto. In caso contrario, occasionalmente potrebbero verificarsi 
eventi imprevisti. Non utilizzare il controller digitale oltre i valori nominali.

•	 Il prodotto è progettato solo per uso interno. Non utilizzare o conservare il prodotto all’aperto o in 
nessuno dei seguenti posti:
-	 Luoghi direttamente soggetti a calore irradiato da apparecchiature di riscaldamento.
-	 Luoghi soggetti a spruzzi di liquido o atmosfera di petrolio.
-	 Luoghi soggetti alla luce solare diretta.
-	 Luoghi soggetti a polvere o gas corrosivi (in particolare gas di solfuro e gas di ammoniaca).
-	 Luoghi soggetti a forti sbalzi di temperatura.
-	 Luoghi soggetti a formazione di ghiaccio e condensa.
-	 Luoghi soggetti a vibrazioni e forti urti.

•	 L’utilizzo di due o più controller affiancati o uno sopra l’altro possono causare un incremento di 
calore interno che ne riduce il ciclo di vita. In questo caso si raccomanda l’uso di ventole per il 
raffreddamento forzato o altri dispositivi di condizionamento della temperatura interno quadro.

•	 Controllare sempre i nomi dei terminali e la polarità e assicurarsi di effettuare una cablatura corretta.
Non collegare i terminali non utilizzati.

•	 Per evitare disturbi induttivi, mantenere il cablaggio dello strumento lontano da cavi di potenza 
con tensioni o corren ti elevate. Inoltre, non collegare linee di potenza insieme o in parallelo al 
cablaggio del controller digitale. Si consiglia l’uso di cavi schermati e condotti separati. Collegare un 
limitatore di sovratensione o un filtro antirumore ai dispositivi che generano rumore (in particolare 
motori, trasformatori, solenoidi, bobine o altre apparecchiature con componenti induttivi). Quando 
si utilizzano filtri antidisturbo sull’alimentazione, controllare tensione e corrente e collegare il filtro 
il più vicino possibile allo strumento. Lasciare più spazio possibile tra il controller e dispositivi di 
potenza che generano alte frequenze (saldatrici ad alta frequenza, macchine per cucire ad alta 
frequenza, ecc.) o sovratensioni.

•	 Un interruttore o un sezionatore deve essere posizionato vicino al regolatore. L’interruttore o il 
sezionatore deve essere facilmente raggiungibile dall’operatore e deve essere contrassegnato 
come mezzo di disconnessione per il controller.

•	 Rimuovere lo sporco dallo strumento con un panno morbido e asciutto. Non usare mai diluenti, 
benzina, alcool o detergenti che contengano questi o altri solventi organici. Possono verificarsi 
deformazioni o scolorimento.

•	 Il numero di operazioni di scrittura della memoria non volatile è limitato. Tenere conto di questo 
quando si utilizza la modalità di scrittura in EEprom ad esempio nella variazione dei dati durante le 
comunicazioni seriali.

1.4	 Tutela ambientale e smaltimento dei rifiuti / Direttiva 
WEEE

Non smaltire le apparecchiature elettriche ed elettroniche tra i rifiuti domestici.
Secondo la Direttiva Europea 2012/19/EU le apparecchiature esauste devono essere raccolte 
separatamente al fine di essere reimpiegate o riciclate in modo eco-compatibile.

2	 Identificazione del modello
La serie EPL200 prevede :
PLC OPEN FRAME, 1 ETHERNET; 2 RS485; 
6 Analog inputs; 1 Analog Outputs; 10 Digital Inputs; 4 Rele 5A, 4 Rele 10A, 4 Digital outputs.
I modelli differiscono per l’alimentazione scondo la seguente tabella:
EPL200-1A 24V AC/DC
EPL200-1BC 115-230V AC
EPL200-1D 12V DC
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3	 Dati tecnici
3.1	 Caratteristiche generali

Tensione alimentazione
EPL200-1A 24 V AC/DC ± 10%
EPL200-1BC 115-230 V AC ± 10%
EPL200-1D 12 V DC ± 10%

Consumo 5W
Condizioni operative Temperatura: 0-45°C; umidità 35..95 RH% senza condensa
Protezione IP20
Peso Circa 100 g

3.2	 Caratteristiche hardware
CPU ARM Cortex H7 @ 480MHz
Memoria Flash 2 Mb / RAM 1 Mb

Ingressi digitali 8 ingressi PNP 12-24Vdc
2 ingressi NPN 12-24Vdc

V
IL

 = 4,4V, V
IH

 = 8,2V 
V

IL
 = 2,5V, V

IH
 = 4,1V

Ingressi encoder/
contatore

3 encoder/contatori sovrapposti agli
ingressi digitali PNP

Risoluzione 32 bit
Frequenza massima 100KHz

Ingressi analogici

4 ingressi configurabili via software
Termocoppie: tipo K, S, R, J, T, E, N, B; con 
compensazione automatica del giunto 
freddo da 0..50°C.
Termoresistenze: PT100, PT500,
PT1000, Ni100, PTC1K, NTC10K (β 3435K)
Potenziometri: 1..150 kΩ

Tolleranza: (@ 25 °C)
± 0.2% ± 1 digit (su F.s.)
Risoluzione: 16bit

2 ingressi configurabili via software
Ingresso VI: 0-10V, 0-20 o 4-20mA.

Tolleranza: (@ 25 °C)
± 0.2% ± 1 digit (su F.s.)
Risoluzione: 16bit

Uscite Relè

4 uscite relè contatto NO comune unico
 

Q0.0-Q0.3 Max 5A per uscita

4 uscite relè contatto NO 
comune unico per Q0.4-Q0.5
comune unico per Q0.6-Q0.7

Q0.4-Q0.7 Max 10A per uscita

Uscite digitali 4 uscite open collector PNP Max 25mA per uscita
Q1.0-Q1.3

Uscite analogiche 1 uscita configurabile via software:
0-10V o 4-20mA Risoluzione: 16bit

RS485 2 porte  con protocollo Modbus RTU 
master/slave Fino a 115200 baud

Porta Ethernet Con protocollo Modbus TCP master/slave

3.3	 Caratteristiche software
Tempo ciclo minimo 1mS
Public objects - 
Parameters (non-volatile) 3800 words, ritenzione dati 150 anni 

Public objects - 
Status variables (volatile) 4096 words

Ritenzione Variabili 2KB 60 giorni di ritenzione con batteria ricaricabile a condensatore
Ritenzione Datablock 2KB 60 giorni di ritenzione con batteria ricaricabile a condensatore
PLC code size 476KB
PLC data size 128KB
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4	 Dimensioni ed installazione

5	 Collegamenti elettrici
Questo strumento è stato progettato e costruito in conformità alle Direttive Bassa Tensione 2006/95/ 
CE , 2014/35/UE (LVD) e Compatibilità elettromagnetica 2004/108/CE e 2014/30/UE (EMC) per l’installa- 
zione in ambienti industriali è buona norma seguire la seguenti precauzioni:
•	 Distinguere la linea di alimentazioni da quelle di potenza.
•	 Evitare la vicinanza di gruppi di teleruttori, contattori elettromagnetici, motori di grossa potenza e 

comunque usare appositi filtri.
•	 Evitare la vicinanza di gruppi di potenza, in particolare se a controllo di fase.
•	 Si raccomanda l’impiego di filtri di rete sull’alimentazione della macchina in cui lo strumento verrà 

installato, in particolare nel caso di alimentazione 230 VAC.                   
	 Si evidenzia che lo strumento è concepito per essere assemblato ad altre macchine e dunque la 

marcatura CE dello strumento non esime il costruttore dell’impianto dagli obblighi di sicurezza e 
conformità previsti per la macchina nel suo complesso.

•	 Per cablare i morsetti utilizzare puntalini a tubetto crimpati o filo di rame flessibile o rigido di 
sezione compresa tra 0.25 e 1.5 mm2 (min. AWG28, max. AWG16, temperatura operativa: min. 70°C). 
La lunghezza di spelatura è compresa tra 7 e 8 mm.
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5.1	 Schema di collegamento

5.1.a	 Alimentazione

12 VDC
24 VAC/VDC
115..230 VAC

5.1.b	 Ingressi digitali PNP 12..24Vdc

2: Ingresso I0.0
3: Ingresso I0.1
4: Ingresso I0.2
5: Ingresso I0.3
6: Ingresso I0.4
7: Ingresso I0.5
39: Ingresso I0.6
40: Ingresso I0.7

5.1.c	 Ingressi digitali NPN 12..24Vdc

46: Ingresso I1.0
47: Ingresso I1.1
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5.1.d	 Ingressi Analogici per Termocoppie

Termocoppie K, S, R, J, T, E, N, B

Rispettare la polarità
Per eventuali prolunghe utilizzare cavo compensato e morsetti 
adatti alla termocoppia utilizzata (compensate)

5.1.e	 Ingressi Analogici per Termoresistenze a 2 fili

Termoresistenze con collegamento a 2 fili
Potenziometri lineari

5.1.f	 Ingressi Analogici per Termoresistenze Pt100 , Ni100 a 3 fili

Per il collegamento a tre fili usare cavi della stessa sezione

5.1.g	 Ingressi Analogici per segnali normalizzati

Segnali in tensione 0..10V;
Segnali in corrente 0..20 mA, 4..20mA

5.1.h	 Uscite Relè Q0.0..Q0.3

Q0.0 .. Q0.3

5A 250 VAC
5A 30VDC

5.1.i	 Uscite Relè Q0.4..Q0.7

Q0.4.. Q0.5

10A 250VAC
10A 30VDC
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5.1.j	 Uscite Digitali open collector

Max 25mA per uscita.

5.1.k	 Uscita Analogica AO1

Configurabile:
0-10 V con 30000 punti ±0.3% (su F.S.) @25 °C;
carico >= 1 KΩ
4-20 mA con 25000 punti ±0.3% (su F.S.) @25 °C;
carico <= 500Ω

5.1.l	 Ingressi Encoder Push-Pull

Usare solo encoder di tipo push-pull
Frequenza massima 100KHz

5.1.m	 Ingressi Contatore
Ingressi contatore:
2: Contatore 1 , PNP
5: Contatore 2 , PNP
46: Contatore 3 , NPN

Frequenza massima 100KHz

5.1.n	 Seriale COM1/RS485

26: (B+) RS485+
27: (A-) RS485-
28: (C) Riferimento 
Collegare l’eventuale schermo del cavo alla TERRA

5.1.o	 Seriale COM2/RS485

1,2: +V Out
4: (B+) RS485+
5: (A-) RS485-
3,6 : (C) Riferimento 
7,8: - Vout
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5.1.p	 Ethernet

Porta Ethernet 10/100 Mbit per la programmazione e connettività 
di rete.

5.1.q	 USB

Porta USB 2.0 per Backup / Restore degli applicativi e delle 
funzionalità di archiviazione di massa (la memory deve essere 
formattata in FAT/FAT32).

5.1.r	 Pulsante S1 per Backup / Restore del sistema (interno)
Backup:
La procedura di backup consente di salvare la configurazione completa del 
dispositivo su una memoria USB sia del codice che delle memorie ritentive.
1 - Accendere il PLC.
2 - Inserire una memoria USB (esterna).
3 - Aprire il coperchio frontale e premere il pulsante S1 per circa 8 secondi (si 
accende il led verde CONFIRM)
4 - Rilasciare il pulsante S1
5 - Attendere il completamento della procedura di Backup.
Durante la procedura il led RUN rosso lampeggia e l’avanzamento della 
procedura viene indicato dall’accensione in sequenza dei led da I.0.0 fino a 
I/Q.1.7. Il led COM giallo indica la presenza della memoria USB.
Al termine della procedura il Led RUN verde si accende fisso.
In caso di errori durante la procedura, il Led RUN rosso si accende fisso.
6 - Spegnere il PLC, togliere la memoria USB e riaccendere il device.

Nel caso il programma sul PLC fosse protetto da password, è necessario inserire nella root della 
memoria USB un file Password.txt contenente la password di protezione del programma in caso 
contrario la procedura di backup non verrà eseguita. Dopo aver eseguito il backup il file può essere 
rimosso dalla memoria.
Al termine del backup verrà generato nella root della memoria USB un file BackupLog.txt contenente 
l’esito della procedura.

Restore:
1 - Inserire una memoria USB contenente il Backup con il PLC spento.
2 - Accendere il PLC tenendo premuto il pulsante S1 (il led verde CONFIRM si 
accende).
3 - Attendere il completamento della procedura di Restore.
Durante la procedura il led RUN rosso lampeggia e l’avanzamento della 
procedura viene indicato dall’accensione in sequenza dei led da I.0.0 fino a 
I/Q.1.7. Il led COM giallo indica la presenza della memoria USB.
Al termine della procedura il Led RUN verde si accende fisso.
In caso di errori durante la procedura, il LEd RUN rosso si accende fisso.
5 - Spegnere il PLC, togliere la memoria USB e riaccendere il device.

5.2	 Significato delle spie di stato
 RUN Acceso fisso indica che il PLC è nello stato di STOP
 RUN Acceso fisso indica il normale funzionamento del PLC

 RUN Lampeggiante in modo alternato ogni 0,5s indica che è in corso la procedura di 
discovery del dispositivo

 COM Si accende per 100 ms ad ogni invio di un frame di comunicazione sulla porta COM1/
RS485
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6	 Suite LogicLab
La Suite LogicLab è l’ambiente di sviluppo di Pixsys per la programmazione del PLC EPL200.
La suite è scaricabile dall’area download del sito pixsys.net e non necessita di codici di attivazione. È 
compatibile con tutte le versioni di Windows 32/64bit a partire da Windows XP SP3 ed è disponibile 
in lingua inglese e in italiano. Dopo aver scaricato il file setup sul PC, avviare l’installazione e seguire 
la procedura. Completata l’installazione, il programma si potrà avviare dall’icona LogicLab  sul 
desktop oppure dal menù “Start” > “PixsysSuite” > “LogicLab”.

6.1	 Cambio lingua

Per cambiare la lingua di visualizzazione è necessario 
aprire la finestra delle opzioni dal menù “File” > 
“Options”, passare alla scheda “Language”, selezionare 
la voce “ITA - italiano” e premere “Select”. 
Confermare quindi con “OK” e riavviare LogicLab per 
rendere effettive le modifiche.

6.2	 Creazione - caricamento di un progetto

Schermata iniziale di LogicLab
•	 Dopo l’avvio dell’applicazione, vengono proposte 

le opzioni per creare o aprire un progetto. 
Eseguire una scansione della rete per rilevare i 
dispositivi connessi riconosciuti dall’ambiente di 
sviluppo o selezionare uno dei dispositivi.

Scansione della rete…
•	 Facendo click sul pulsante Scan Network,  

LogicLab esegue una ricerca di tutti i dispositivi 
programmabili presenti sulla rete e compila la 
tabella “Scan result”

•	 In base al tipo di dispositivo rilevato, tramite 
i pulsanti presenti nella tabella sono possibili 
alcune operazioni direttamente sul dispositivo 
selezionato.

•	 Per EPL200, il pulsante  consente di avviare la 
modalità Discovery sul dispositivo selezionato: il 
LED run lampeggia alternativamente rosso/verde 
per circa 5 secondi, in modo da poter stabilire con 
certezza se si tratta del giusto dispositivo nel caso 
ne siano stati rilevati più di uno dello stesso tipo 
durante la scansione.

•	 Per EPL200, tramite il pulsante  è possibile 
aprire una schermata in cui modificare le 
impostazioni di rete del dispositivo.
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Apertura di un progetto esistente:
•	 Con LogicLab aperto, fare click sul pulsante “Apri 

progetto” oppure selezionare uno degli ultimi 
progetti aperti dall’elenco proposto.

•	 Con LogicLab chiuso, entrare nella cartella del 
progetto e fare doppio click sul file con il nome 
del progetto desiderato che avrà l’icona  ed 
estensione “.plcprj”.

Creare un nuovo progetto:
•	 Premere il pulsante “Nuovo Progetto” oppure, dalla 

tabella “Scan result” selezionare il dispositivo e 
premere il pulsante .

•	 Nella finestra visualizzata, digitare un nome per il 
progetto ed identificare la cartella dove verranno 
inseriti i file del progetto. Selezionare infine il 
dispositivo che si vuole programmare.

Information! selezionando il flag “rispetta maiuscole/minuscole”, una variabile che contiene una 
lettera maiuscola sarà intesa come diversa da un’altra di uguale nome ma con tale lettera minuscola. 
Consigliamo quindi di lasciare disabilitata tale selezione, per evitare confusione durante la stesura del 
codice programma.

6.3	 Collegamento al target
Si elencano di seguito i requisiti necessari per il corretto collegamento tra target (dispositivo da 
programmare) e l’ambiente di sviluppo su PC (LogicLab).

Requisiti da verificare sul target:
•	 dispositivo acceso e avviato
•	 configurato con indirizzo IP statico compatibile con la rete dove si trova ed il PC con cui si 

dovrà connettere. Di default, l’indirizzo IP del dispositivo è 192.168.0.99, quindi il PC dove si sta 
sviluppando dovrà avere la stessa rete e classe (in questo caso 192.168.0.XXX) ma indirizzo fisico 
diverso (cioè le ultime 3 cifre dell’indirizzo IP, con un qualsiasi numero compreso tra 1 e 255, 
diverso da 99). Se è necessario cambiare l’indirizzo IP del dispositivo rispetto a quello di default, 
fare riferimento alle indicazioni riportate nel paragrafo precedente.

•	 connessione con cavo di rete (diretto o cross) direttamente al PC o attraverso uno switch di rete

Requisiti da verificare sul PC di sviluppo:
•	 indirizzo IP compatibile con la rete esistente dove si trova e con l’indirizzo IP configurato nel 

target (vedi punti precedenti)
•	 antivirus/firewall che permetta la connessione a dispositivi nella rete (di norma sono già 

configurati correttamente)
•	 LogicLab configurato per connettersi al target collegato che si vuole programmare: per fare ciò, 

navigare sul menù “On Line” > “Imposta comunicazione” e nella finestra che appare, premere il 
pulsante “Properties” e poi alla voce “IP Address” inserire l’indirizzo IP del target, lasciando inalterato 
tutto il resto. Nel caso di reti molto lente o di una configurazione di rete con diversi switch, è 
possibile aumentare il valore “Timeout” (espresso in mS).
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L’immagine rappresenta la configurazione di default

Confermare tutte le finestre premendo su “OK” e salvare attraverso l’icona  o attraverso il menù “file”
> “Salva Progetto”.
A questo punto, per verificare che la configurazione del LogicLab e del target sia corretta, si può 
effettuare la connessione premendo l’icona  oppure dal menù “On Line” > “Connetti”. Se la 
connessione va a buon fine la barra di stato in basso a destra visualizzerà “CONNESSO” e “NO CODICE” 
ad indicare che il target è connesso e non ha codice al suo interno oppure “CODICE DIFF” ad indicare 
che il codice che si sta visualizzando non corrisponde a quello che risiede nel target.

6.4	 Compilazione e scaricamento del codice
Una volta inserito il codice progetto è necessario compilarlo per verificare che non ci siano errori, 
premendo il tasto F7, attraverso l’icona  oppure dal menù “Progetto” > “Compila”.
Se la compilazione va a buon fine si può trasferire il programma al target premendo il tasto F5, 
attraverso l’icona  oppure dal menù “On Line” > “Trasferimento codice”.
A questo punto la barra di stato visualizzerà “CONNESSO” e “SORGENTE OK” indicando che il programma 
in esecuzione nel target corrisponde a quello che si sta visualizzando sul PC.

6.5	 La watch window
Se il programma in esecuzione nel target corrisponde a quello che si sta visualizzando sul PC, la barra 
di stato visualizza “CONNESSO” e “SORGENTE OK” ed è quindi possibile utilizzare la finestra di “Watch” 
per verificare, in tempo reale, lo stato delle variabili utilizzate nel progetto. Per abilitare la finestra di 
“Watch”, premere i tasti CTRL+T oppure usare il menù “Vista” > “Finestra strumenti” > “Watch”. 
Per aggiungere una variabile alla finestra di “Watch” è sufficiente trascinarla al suo interno oppure 
premere l’icona  e selezionarla manualmente.

Da questo momento, la finestra di “Watch” comincerà 
a visualizzare il valore della variabile inserita, in tempo 
reale.

Attraverso gli appositi pulsanti  è possibile inoltre salvare, caricare e aggiungere all’elenco 
delle variabili, una watch-list già esistente.
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Se si desidera cambiare il formato di visualizzazione, è 
sufficiente selezionare la variabile e premere l’icona 
Dalla finestra che appare selezionare quindi il formato 
desiderato e confermare con “OK”.

7	 Le risorse locali dell’EPL200 “Local IO Mapping“
Le risorse hardware disponibili nell’EPL200 sono disponibili nella sezione “Local IO Mapping” del 
programma, suddivise per categorie in modo da renderne più fruibile ed agevole l’utilizzo. La sezione 
“Parametrization” permette di impostare tutti i parametri che regolano il funzionamento del dispositivo. 
La configurazione dei parametri viene automaticamente gestita nella fase di inizializzazione del PLC. 
Ulteriori modifiche dei parametri durante l’esecuzione del programma devono essere rese attive 
richiamando la funzione di sistema “sysApplyIOConfiguration(0);”

La gestione delle “Local IO Mapping” permette di 
mappare su delle variabili utilizzabili dal programma 
tutte le risorse locali disponibili nell’EPL200.
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7.1	 Parametrizzazione
1	 Tipo sensore AI1
2	 Tipo sensore AI2
3	 Tipo sensore AI3
4	 Tipo sensore AI4

Configurazione ingresso analogico / selezione sensore
 0	 Disabilitato (Default)
 1 	 Tc K	 -260 °C..1360 °C
 2	 Tc S	 -40 °C..1760 °C
 3	 Tc R	 -40 °C..1760 °C
 4 	 Tc J 	 -200 °C..1200 °C
 5 	 Tc T 	 -260 °C..400 °C
 6 	 Tc E 	 -260 °C..980 °C
 7 	 Tc N 	 -260 °C..1280 °C
 8 	 Tc B 	 100 °C..1820 °C
 9 	 PT100 	 -100 °C..600 °C
10 	 NI100 	 -60 °C..180 °C
11 	 NTC-10K 	 -40 °C..125 °C 
12 	 PTC-1K 	 -50 °C..150 °C
13 	 PT500 	 -100 °C..600 °C
14 	 PT1000  	 -100 °C..600 °C
15 	 Potenziometer (impostare il valore nel parametro 20..23)
16	 Compensazione Pt100 ( solo per parametro 2 , 3 )

5	 Tipo sensore AI5
6	 Tipo sensore AI6

Configurazione ingresso analogico / selezione sensore
 0	 Disabilitato (Default)
1 	 0..10V
2 	 0..20mA
3 	 4..20mA

7	 Tipo Gradi
0	 °C 	 (Celsius) (Default)
1	 °F 	 (Fahrenheit)
2	 K 	 (Kelvin)

8	 Limite inferiore ingresso AI1
9	 Limite inferiore ingresso AI2
10	 Limite inferiore ingresso AI3
11	 Limite inferiore ingresso AI4
12	 Limite inferiore ingresso AI5
13	 Limite inferiore ingresso AI6

Limite inferiore dell’ingresso analogico solo per normalizzati. Es: con ingresso 4..20 mA questo 
parametro indica il valore associato a 4 mA
-32768..+32767, Default: 0.

14	 Limite superiore ingresso AI1
15	 Limite superiore ingresso AI2
16	 Limite superiore ingresso AI3
17	 Limite superiore ingresso AI4
18	 Limite superiore ingresso AI5
19	 Limite superiore ingresso AI6

Limite superiore dell’ingresso analogico solo per normalizzati. Es: con ingresso 4..20 mA questo
parametro indica il valore associato a 20 mA
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-32768..+32767, Default: 1000

20	 Valore potenziometro AI1
21	 Valore potenziometro AI2
22	 Valore potenziometro AI3
23	 Valore potenziometro AI4

Seleziona il valore del potenziometro collegato all’ingresso analogico.
1..150 kohm, Default: 10kohm

26	 Limite lineare oltre ingresso AI1
27	 Limite lineare oltre ingresso AI2
28	 Limite lineare oltre ingresso AI3
29	 Limite lineare oltre ingresso AI4
30	 Limite lineare oltre ingresso AI5
31	 Limite lineare oltre ingresso AI6

In caso di ingresso lineare, permette al processo di superare i limiti (Par. 8..13 e 14..19).
0 Off
1 On

32	 Calibrazione offset AI1
33	 Calibrazione offset AI2
34	 Calibrazione offset AI3
35	 Calibrazione offset AI4
36	 Calibrazione offset AI5
37	 Calibrazione offset AI6

Calibrazione offset. Valore che si somma o sottrae al processo visualizzato (es: normalmente
corregge il valore di temperatura ambiente).
-10000..+10000 [digit] (gradi.decimi per sensori di temperatura). Default 0.

38	 Calibrazione guadagno AI1
39	 Calibrazione guadagno AI2
40	 Calibrazione guadagno AI3
41	 Calibrazione guadagno AI4
42	 Calibrazione guadagno AI5
43	 Calibrazione guadagno AI6

Calibrazione guadagno. Valore che si moltiplica al processo per eseguire calibrazione sul punto
di lavoro. Es: per correggere la scala di lavoro da 0..1000°C che visualizza 0..1010°C, fissare il
parametro a -1.0
-1000 (100.0%)...+1000 (+100.0%), Default: 0.0.

44 - 49	 Riservato

50	 Filtro ingresso AI1
51	 Filtro ingresso AI2
52	 Filtro ingresso AI3
53	 Filtro ingresso AI4
54	 Filtro ingresso AI5
55	 Filtro ingresso AI6

Filtro lettura ingresso analogico: aumenta la stabilita del valore della lettura analogica. Indica il
numero di campionamenti da mediare nel calcolo del processo.
1...50. (Default: 10)

56	 Massima differenza per nuovo campionamento AI1
57	 Massima differenza per nuovo campionamento AI2
58	 Massima differenza per nuovo campionamento AI3
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59	 Massima differenza per nuovo campionamento AI4
60	 Massima differenza per nuovo campionamento AI5
61	 Massima differenza per nuovo campionamento AI6

Definisce il valore assoluto massimo di differenza tra il valore attuale del processo e il nuovo
campionamento per ritenere tale valore accettabile (e quindi inserito nella media gestita dal
parametro “50..55 Filtro ingresso”) o scartarlo.
1..32767 [decimi di °C o digit], Default: 10,0 °C

62	 Durata massima scarto campionamento AI1
63	 Durata massima scarto campionamento AI2
64	 Durata massima scarto campionamento AI3
65	 Durata massima scarto campionamento AI4
66	 Durata massima scarto campionamento AI5
67	 Durata massima scarto campionamento AI6

Determina la durata massima per la quale i campionamenti dell’ingresso analogico possono
venire scartati se considerati non accettabili (vedi parametri 72..73). Scaduto tale tempo qualsiasi
valore di campionamento verra considerato valido.
0..200 [decimi di secondo], Default: 1,0 s

68 - 70	 Riservato

71	 Tipo uscita AO1
Seleziona la modalità di funzionamento dell’uscita analogica.
0	 0-10 V (Default)
1	 4-20 mA

72	 Limite inferiore uscita AO1
Limite inferiore range uscita continua (valore associato a 0V o 4mA).
-32768...+32767 [digit], Default: 0.

73	 Limite superiore uscita AO1
Limite superiore range uscita continua (valore associato a 10V o 20mA).
-32768...+32767 [digit], Default: 1000.

74	 Stato uscita in errore AO1
Definisce come si comporta l’uscita in caso di errore.
0	 Mantiene il valore (Default)
1	 Imposta il valore del parametro seguente

75	 A01 valore output in errore
Determina il valore dell’uscita analogica in caso di errore o anomalia.
Il valore deve essere compreso tra i limiti minimo e massimo dell’uscita.
-32768..+32767 [digit], Default: 0.

76	 Filtro ingresso digitale
Definisce il tempo per cui l’ingresso digitale deve rimanere stabile prima di essere considerato
valido.
0..250 [base 1,0 ms], Default: 5 x 1,0 = 5 ms.

77	 Riservato

78	 Encoder/contatore setup 1
79	 Encoder/contatore setup 2
80	 Encoder/contatore setup 3

Determina la modalità di funzionamento dell’ingresso encoder o contatore monodirezionale.
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0	 Disable
1 	 Counter Up
2 	 Counter Down
3 	 Encoder x2 phase A-B
4 	 Encoder x4 phase A-B
5 	 Encoder x2 phase A-B-Z
6 	 Encoder x4 phase A-B-Z

81	 Encoder/contatore preset 1
82	 Encoder/contatore preset 2
83	 Encoder/contatore preset 3

Determina il valore che verrà caricato nel registro dei conteggi dell’encoder o del contatore, al 
verificarsi del comando di caricamento.
-2147483648..2147483647  [digit], Default: 0.

87	 Tempo offline
Determina il tempo in ms impiegato dal plc per attivare le uscite di “errore” nel caso di interruzione 
della comunicazione con l’I/O integrato.
0 Off
1 to 60000 time in ms

88 - 150	 Riservato

7.2	 Digital Inputs
IW0.0	 System digital inputs word

Questa word contiene lo stato dei 10 ingressi digitali del EPL200.
Bit 0: I.0.0
…
Bit 7: I.0.7
Bit 8: I.1.0
Bit 9: I.1.1

7.3	 Digital Outputs
QW0.0	 System digital outputs word

Questa word contiene lo stato delle 16 uscite digitali del EPL200.
Per attivare le uscite impostare a “1” il bit corrispondente su questa word.
Bit 0: Q.0.0
…
Bit 7: Q.0.7
Bit 8: Q.1.0
…
Bit 11: Q.1.3

7.4	 Analog Inputs
IW1.0  	 System analog input AI1
IW1.1	 System analog input AI2
IW1.2  	 System analog input AI3
IW1.3  	 System analog input AI4
IW1.4  	 System analog input AI5
IW1.5  	 System analog input AI6

Queste word contengono il valore degli ingressi analogici del EPL200. Per gli ingressi configurati 
come sensori di temperatura, il valore è espresso in decimi di grado. Nel caso di ingresso 
analogico fuori range, in corto o aperto, il valore riportato sarà -32768 (corto) o 32767 (aperto).
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7.5	 Analog Outputs
QW1.0	 System analog output AO1

Questa word contiene il valore dell’ uscita analogicha del EPL200. Per impostare un determinato 
valore sull’uscita analogica corrispondente, scrivere il valore su queste word in accordo con i 
limiti minimo e massimo dell’uscita fissati nella tabella parametrization

7.6	 Encoder/counter
EV01 	 System encoder 1 value
EV02 	 System encoder 2 value
EV03 	 System encoder 3 value

Queste variabili a 32 bit contengono il valore in conteggi degli encoder/contatori del EPL200

EC1000_1	 System encoder 1 counts 1s
EC1000_2	 System encoder 2 counts 1s
EC1000_3	 System encoder 3 counts 1s

Queste variabili a 32 bit contengono il numero di conteggi degli encoder/contatori del EPL200 
rilevati nell’ultimo secondo. Il dato viene aggiornato ogni 1,0s.

EC100_1	 System encoder 1 counts 100ms
EC100_2	 System encoder 2 counts 100ms
EC100_3	 System encoder 3 counts 100ms

Queste variabili a 32 bit contengono il numero di conteggi degli encoder/contatori del EPL200 
rilevati negli ultimi 100ms. Il dato viene aggiornato ogni 100ms

ECMD_1	 System encoder 1 command
ECMD_2	 System encoder 2 command
ECMD_3	 System encoder 3 command

Queste word  si utilizzano per inviare i comandi agli encoder.
Bit0 = Carica valore preset
Bit1 = Carica preset al prossimo impulso Z
I bits dei comandi vengono portati automaticamente a 0 una volta
eseguito il comando
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Responsabilità limitata
Pixsys S.r.l. garantisce le proprie apparecchiature elettroniche per un periodo di 12 mesi a decorrere 
dalla data di fatturazione. La garanzia del Costruttore è limitata alla riparazione o sostituzione delle 
parti che presentino difetti di fabbricazione e che siano rese franco nostra sede citando il numero di 
autorizzazione al reso (procedura interna autorizzazione RMA). Pixsys declina ogni responsabilità per 
incidenti e danni a persone o cose derivanti da manomissione (inclusi tentativi di riparazione da parte 
di personale non autorizzato), condizioni ambientali non idonee, installazione scorretta, uso errato, 
improprio e comunque non conforme alle caratteristiche dello strumento dichiarate nella documen- 
tazione tecnica. In nessun caso la responsabilità del costruttore eccede il valore della strumentazione. 
La garanzia non copre in alcun modo i problemi derivanti dall’installazione di applicativi software 
successiva alla vendita, ed in particolare i danni conseguenti all’esecuzione di malware. Eventuali 
interventi di assistenza da parte di Pixsys per il ripristino di sistema operativo o programmi saranno 
soggetti alla tariffa di assistenza vigente.

Note / Aggiornamenti
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Read carefully the safety guidelines and programming instructions contained in this manual 
before using/connecting the device.

Prima di utilizzare il dispositivo leggere con attenzione le informazioni di sicurezza e settaggio 
contenute in questo manuale.

PIXSYS s.r.l.
www.pixsys.net

sales@pixsys.net - support@pixsys.net 

online assistance: http://forum.pixsys.net

via Po, 16  I-30030
Mellaredo di Pianiga, VENEZIA (IT)

Tel +39 041 5190518

2300.10.400 revA
150425
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